Resuscitating the Much Maligned APA:

A Sample Paper

By

Sonya Grypma

ID # 123456

Submitted in Partial Fulfillment of Course Requirements for

Nursing 000

Professor Ima Nurse

Trinity Western University

June 4, 2010

Author Note

Special thanks to Dr. Rick Sawatzky, Dr. Jean Harrowing, Duncan Dixon and members of the TWU School of Nursing and TWU Library for their helpful suggestions and advice.
Resuscitating the Much-Maligned APA: A Sample Paper

Pity the poor APA. Much maligned, the American Psychological Association Style (APA) for writing papers has been charged as being the cause of much distress among nursing students, both in Canada and abroad (FakeStats, 2009). Indeed, the almost universal frustration with APA formatting, citing and referencing has been the glue that has held together generations of nursing students in Canada. Those of us who took our baccalaureate education in the 1980s were among the first to come to intimately know the dear old first edition of APA. It seems like just yesterday that we were trying to figure out how to type a proper title page using our, well, typewriters. How simple life was in those pre-internet days, with only paper copies of books and journals to contend with. Or was it? In many ways not much has changed with APA. The rallying cry from students persists: Please, can you just show me what I’m supposed to do?

The purpose of this paper is to showcase, through the use of extraneous ideas and fake citations, how students in the TWU School of Nursing are expected to use APA for their course papers. It is not intended to show students what the content of a paper should look like: This is decidedly not a formal paper. To those of you who are thinking, hey, if this is a fake paper, how can I trust it, I say this: My purpose is simply to show you at-a-glance what proper formatting, citing, and referencing would look like in an actual paper. If I were to attempt to write a sample paper using real resources, it would probably take me until your graduation ceremonies to complete it. Let’s be clear: this paper is not meant to replace your APA 6th edition (American Psychological Association, 2010). You will still need your dear old APA book for all the strange and nuanced ways of writing papers that are not addressed here. Rather, it is to highlight the basics that nursing students tend to struggle with. My hope is that when you hear those chilling words, “you are expected to use APA”, you will hereafter exclaim, “Ah, yes, APA. No problem.”
The Daunting Threesome: Formatting, Citing, and Referencing

Formatting: The Skeletal Frame

Okay, I don’t know if formatting could really be called a skeletal frame. I am using human anatomy to appeal to the purists out there who think that writing papers should not be a priority in a clinical-based profession. You are not alone, you of the “how-does-where-I-place-my-page-numbers-make-me-a-better-nurse” contingent. I confess, I was there once, too. My own admiration of the APA formatting style came long after I graduated, influenced in no small part by my professorial role of grading papers. As Gertrude Miasma (2007) so aptly wrote, “No one loves, and hates, APA more than university professors” (p. 210).

Let’s be honest; the love part boils down to this: When students use APA formatting, it is oh-so-much-easier to grade the papers. Formatting is what we mean when we talk about things like the proper use of margins (2.54 cm), spacing (double), font (Times New Roman 12), number insertion (upper right corner), the proper placement of title, headings and subheadings, and the all important components of the title page. Requiring students to use APA assures me, for example, that if I assign a five-page limit, the five-page paper before me is not really seventeen pages squeezed into five by changing the margins to 0.02 cm, single-spacing, and using Arial black narrow 8 font. Furthermore, having page numbers and headings in the top right hand corner of every page reminds me whose paper I’m reading when I’m marking my 49th twenty-page essay on, say, the impact of endocrinology research on diabetic care in the state of Georgia (fake example alert). Finally, formatting simply makes the paper look more professional. Numerous studies support the assertion that professors are impressed by papers that carefully follow APA formatting guidelines (Blackstone, Reeves, & Tootle, 2006; Jones et al., 2004; Marquis &
Hollywood, 2002). “Clean papers,” as they are referred to in the lexicon of the Most Famous Nursing School of all Time, are invariably favourably received (Claudius, 2008, p. 23). Translation: Higher grades for you.

‘And the hate part? Quering (2000) argued that university professors typically don’t enjoy being distracted from students’ wonderful prose by having to address nigging questions like, is this really Times New Roman 12 font or do I need new bifocals? In particular, few professors find APA-style title pages visually appealing (Travelbee, 2009). James Jameson (2009) has called APA title pages “a wart on the nose of nursing manuscripts” (para. 2).

Travelbee contends that it is a shame not to make full use of the creative graphic styles offered by Microsoft® Office Word 2007 (Microsoft Corporation, 2006) (have you seen the Cambria font used for Heading 1? Or the colourful Transcend header style?). Wouldn’t it be more interesting to read if the heading of this section was in a fancy font? Or in colour? But, alas, it is not to be. As Maddison (2003) suggested, as long as nurses live and move and have our being, we shall be bound to this one unchanging aspect of our profession: standardized formatting of papers. We might as well get used to it.

A final note about formatting for Microsoft Word 2007® users. To date, an estimated 127,000 nursing students have been driven to distraction by this one thing: non-APA-style defaults (Perry, 2009a) (see Table 1). In order to maintain your sanity during the duration of your studies, a number of nursing scholars have recommended that you customize your defaults to conform to APA standards (Petty & Potsworth, 2000; deCalibra, 2003; Perry, 2009b). To change font defaults, click on the Font dialogue box under the Home tab (then click default) (see Figure 1). To change margin defaults, click on the Page Setup dialogue box under the Page Layout tab (then click default). And to change indent and spacing defaults, click on the
Paragraph dialogue box under the Page Layout tab (then click default). This is particularly handy for that pesky automatic extra space between paragraphs. Changing default settings has been found to increase the quality of life in students across a wide-range of disciplines (Baskin & Robyns, 2005; Lens & Glass, 2003). As Doc Martins (2005) wrote, “failing to reset default settings is akin to failing to tie your shoes: you will keep tripping up” (p. 456).

**Citing: Whose Line is it Anyways?**

Apart from a popular volume variously referred to as the APA manual and “that annoying book”, little has been written on the subject of citations. The term citation refers to that author name and date you often see inserted at the end of an idea or a sentence – say, Hamilton (1992), the original citation guru. Since almost every conceivable form of citation can be found somewhere between the covers of the APA tome, I thought we could make the best use of our time together by focusing on trouble-spots – that is, the top four questions-asked-by-at-least-one-student-in-every-class. In no particular order, here they are: What is the difference between citing and quoting? What do I do about citing the same source in one paragraph? How do I cite emails or other casual discussions? And, can I cite information taught in a course lecture?

Starting with the difference between a citation and a quotation, the former is generally used when you are paraphrasing someone’s ideas (Smith, 2001) whereas the latter is used when you are so impressed by what an author has written that you feel as though there is “simply no way that anything I wrote in my own words would be able to convey the witticism or otherwise general wisdom” of the author you are quoting (Smith, 2007, p. 45). In terms of citing the same source in one paragraph, let’s say that everything else I’m writing in this paragraph is inspired or quoted by this Smith fellow. Take a look at what I’m doing, and see if you can follow the different ways to cite the same person in one paragraph. Which brings us to the third question:

**Example of citing same author in paragraph**
citing from emails. You know, I had this fascinating discussion with John Smith last winter, and he told me in an email that writing a sample paper like this would revolutionize nursing education (Smith, personal communication, January 23, 2008). In fact, Smith wrote about the need for sample papers in his bestseller, Recovering the Lost Art of Referencing (2001). Perhaps Smith’s most salient point was brought to the fore when he was a guest lecturer in Nursing 100 where he noted that the only thing separating nursing students from astrophysicists was a love for editing – and a graduate degree in quantum physics (Smith, 2009).

Perhaps you’re reading this and thinking, okay, this does not help. I still don’t know how to cite. Okay, now don’t get testy – we’re not quite done yet. The thing is, to really get the full picture, you will have to go to the reference list and look at John Smith – or, as our dear old APA likes to call him, Smith, J. And, you can see that I’ve layered on a few textboxes here and there to try to draw your attention to various things in the paragraph (caveat: the addition of random textboxes is not standard APA). Really, I’m trying my best. But there is a reason that the 6th edition of the APA publication manual (APA, 2010) has 35,000 pages (approximately). Sigh. Perhaps the greatest value of this essay is the way that it drives you back into the arms of your own cherished copy of the APA manual. Um, yes, that has been my, uh, secret intention all along. But I digress. To those who have persevered thus far, you will be rewarded, because the most exciting section is next: referencing.

**Referencing: Where I Found the Stuff I Wrote About**

When it comes to formatting I feel your pain. Actually I feel your pain about referencing, too. Remember, many professor-types learned APA when there were only paper copies of sources to contend with. The growth of new electronic sources is mind-numbing, and in terms of referencing online sources, we are just as apt to thumb through our copies of APA manual (APA,
2010) (or scroll through our favourite online APA sources) as you are. There will undoubtedly be new and unforeseen sources that we will be drawing on in the future, ensuring our dependence on APA through an infinite number of updates. So, once again I am not going to attempt to reiterate everything in dear old APA (or, more precisely, dear new APA). Rather, I will zero in on a few key areas that nursing students struggle with.

To be honest, students actually do quite well with referencing. Referencing – or the “Reference List” in APA lingo, is really just an alphabetical list of all the sources you cited throughout your paper. Students tend to do just fine with straightforward sources – like books, book chapters and journal articles. When it comes to proper indenting, italicizing and capitalizing these sources, nursing students are second to none. However, as with citing, it is the referencing of unusual sources that stump students (e.g., personal communication, web pages, classroom lectures). The best thing to do is to find a sample list, like the one at the end of this essay, and use it as a template for your source – matching it italics for italics, if you will. If you are able to copy, you have all you need to start in on the experience of referencing for yourself! However, before sending you off into the netherworld of sample reference lists to fend for yourself, I feel compelled to tuck a few last pointers into your backpack. Then I promise I will let you go with a heartfelt fare-thee-well.

First, plain and simple: if you quote or cited information from any source, make sure it is in the reference list, and vice versa. Unlike a bibliography, a reference list should only contain the sources you’ve cited, not everything you’ve read on the topic.

Second, don’t forget your APA formatting. A reference list has the same margins & spacing as the rest of your paper.
Finally, it is worth your while to discipline yourself to reference correctly. By third year, you may well be able to recognize at a glance whether you’ve used proper APA. It does get easier, but only if you work at it. Resist the temptation to ask your professor “how do you want me to reference this?” If you’re in first or second year, you might be told, “take a look at your APA manual or Dr. Grypma’s stellar essay, The Much-Maligned APA.” And, if you are in third or fourth year or in the MSN program, brace yourself: In answer to your question “how do you want me to reference this?” your professor might simply respond, “Correctly!” Referencing software can greatly expedite the formatting in text citations and reference list. Students at Trinity Western University can freely use the RefWorks® software (RefWorks, n.d.) (available through the TWU library) for this purpose. Remember, however, that no software is flawless; you must carefully check software-generated citation formats and reference list.

**Conclusion: Ode to Dear Old APA**

You’ve had a long day. I’m feeling a bit guilty for sending you away with such a curt response. Never fear, you’ll learn APA. *But not by osmosis. It will take some discipline.*

Now, I have something to confess, and this will be the only time I say this so listen well: When I was a nursing student I made up my own cheat sheet for APA. It was my way of coping since I found dear old APA to be a bit tiresome. My personal copy of APA was well worn and, in the days before Post-it Notes®, filled with folded corners marking the key pages, but my cheat sheet was indispensable. When I became a nurse historian and was required to ditch APA for the more exciting Chicago Manual of Style, I silently cheered. No more APA! Alas, by the time I returned to APA as a nursing instructor, the poor old thing had already gone through a metamorphosis of four editions. My cheat sheet no longer passed muster. So, in memory of dear old APA (1st ed.), this is my gift to you. Your own personal cheat sheet. Use it well.
References


Hamilton, I. (1922). Notes for a lecture on citations and references. Virginia Henderson Fonds (Box T45). Archives of the American Society of Publishers, University of Phenberg, Johnsonville, IN.


Smith, J. (2009, February). *Nursing and astrophysics: A primer*. Guest lecture presented in Nursing 200, Trinity Western University, Langley, BC.


[Additional examples of referencing for primary/historical sources]

[Photograph of Graduating Class of MGH]. (ca. 1920s). Maddison General Hospital Fonds (Box 10, File 214). Fort Museum and Archives, Fort Maddison, BC.


Remember that archival sources may still be under copyright, requiring permission from the copyright holder before they may be used.
Table 1

*Numbers of Undergraduate Nursing Students Driven to Distraction by APA in Western Canadian Provinces, 1998 - 2008*

<table>
<thead>
<tr>
<th>Year¹</th>
<th>British Columbia</th>
<th></th>
<th>Alberta</th>
<th></th>
<th>Saskatchewan</th>
<th></th>
<th>Total</th>
<th></th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Total</td>
<td>distracted</td>
<td>Total</td>
<td>distracted</td>
<td>Total</td>
<td>distracted</td>
<td>Total</td>
<td>distracted</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>180</td>
<td>17</td>
<td>190</td>
<td>18</td>
<td>95</td>
<td>10</td>
<td>465</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>170</td>
<td>8</td>
<td>180</td>
<td>16</td>
<td>90</td>
<td>8</td>
<td>440</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>165</td>
<td>6</td>
<td>175</td>
<td>12</td>
<td>85</td>
<td>6</td>
<td>425</td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>150</td>
<td>9</td>
<td>172</td>
<td>10</td>
<td>83</td>
<td>7</td>
<td>406</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>665</td>
<td>40</td>
<td>717</td>
<td>56</td>
<td>353</td>
<td>31</td>
<td>1,736</td>
<td>127</td>
<td></td>
</tr>
</tbody>
</table>

*Note.* Based on data reported by Perry (2009a). The reported numbers are divided by 1,000. ¹Year in undergraduate nursing program.
Figure 1. Setting the default font in Microsoft® Office Word 2007 (Microsoft Corporation, 2006).